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Abstract:  In the paper, first a basic concept 
of distributed parameter system models in the 
form of lumped-input/distributed-output systems 
is introduced. Next, modeling of temperature 
fields of a melting glass process as distributed 
parameter system by using of finite element 
method based software package COMSOL 
Multiphysics is presented. Distributed 
characteristics either in stationary or transient 
form obtained there by numerical solution are 
exported to the MATLAB & Simulink 
Environment, where lumped and distributed 
models for control synthesis purpose are created. 
Finally, by means of Distributed Parameter 
Systems Blockset for MATLAB & Simulink - 
Third-Party Product of The MathWorks, 
feedback distributed parameter system of control 
is arranged. There for chosen control synthesis 
methods, simulation of control process of 
temperature field of melting glass is executed 
and analyzed.  
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1. Introduction 
 

Technological processes in the engineering 
practice from point of view of systems and 
control theory are frequently in the form of 
distributed parameter systems (DPS) with 
dynamics defined on complex-shape 3D 
definition domains. Modeling and simulation in 
this area is now widely accepted as an important 
tool in product design and process development 
to improve both productivity and quality. For 
modeling and dynamical analysis of DPS wide 
possibilities are offered by COMSOL 
Multiphysics Environment based on efficient 
numerical solution of sets of partial differential 
equations by finite element method (FEM).  

Techniques of FEM based modeling and 
design of control synthesis methods of DPS 
which is acceptable for various technological 

processes, is demonstrated on modeling and 
simulation of control of temperature fields of the 
glass melting furnace. For control synthesis 
purpose, numerical models in the form of a 
lumped-input/distributed-output system (LDS) 
were created by means of numerical dynamical – 
FEM solution.  

Analysis of formulated models, simulation of 
temperature fields, but also design of control 
synthesis was carried out using the Distributed 
Parameter Systems Blockset for MATLAB & 
Simulink - Third-party software product of The 
MathWorks, developed at the Institute of 
Automation, Measurement and Applied 
Informatics, Faculty of Mechanical Engineering, 
Slovak University of Technology [7]. 
  
2. LDS models of DPS 
 

Generally, DPS are systems whose 
state/output variables, X(x,y,z,t)/Y(x,y,z,t) are 
distributed variables or fields of variables, where  
(x,y,z) are spatial coordinates in 3D. In the 
mathematical theory, dynamics of DPS is 
described by partial differential equations (PDE) 
with boundary and initial conditions, [1], [2], [3]. 
As to the input/output relations, PDE define 
distributed - input/distributed - output systems 
(DDS) between distributed input, U(x,y,z,t) and 
distributed output variables, Y(x,y,z,t), at initial 
and boundary conditions given. Distributed 
parameter systems very frequently are found in 
various technical and non-technical branches in 
the form of LDS, [5], see Fig. 1.   

 

 
 

Figure 1. Lumped-input/distributed-output system 
representation of distributed parameter systems.   

Excerpt from the Proceedings of the COMSOL Conference 2010 Boston

http://www.comsol.com/conf_cd_2011_us


2.1 Dynamics of LDS  
 

Output of the linear LDS in time domain, or 
in s-domain is in the form:  
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where ( ), ,x x y z=  is position vector in 3D, 

( )iU t - lumped input quantity, ( ),i x tG - i-th 

distributed impulse response, ⊗ - denotes 

convolution product, ( ),iY x t - system response 

to the i-th input, ( ),iS x s - i-th transfer function, 

[6]. When  ( )iU t  is a unit-step (Heaviside) 

function, ( ),iY x t  is in the form of distributed 

transient response function ( ),i x tH .  

For a discrete-time system considering zero-
order hold (ZOH) units, the overall distributed 
output variable of LDS and ZOH can be 
expressed in the form: 
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where ⊕ denotes convolution sum. For points 

( ), ,i i i ix x y z=  located in surroundings of 

lumped input variables, ( )iU t , where partial 

distributed transient responses ( ),i ix tH  attain 

maximal amplitudes, partial particular distributed 
output variables are obtained in time-domain, or 
in z-domain respectively:  
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For the space dependency and in steady-state 

we can define reduced transient step responses 
between i-th input variable at point 

( ), ,i i i ix x y z=  and corresponding partial 

particular distributed output variable in steady-
state:  
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Dynamics of LDS is decomposed to time and 
space components. In the time dependency, there 
are, discrete transfer functions of the form 
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2.2 Feedback control loop based on LDS  

 
Structure of DPS feedback control loop 

based on LDS is on Fig. 2, where the goal of 
control is to ensure the steady-state control error 
to be minimal: 

( ) ( ) ( )min , min , ,E x W x Y x∞ = ∞ − ∞        (7) 

 
 
Figure 2. Distributed parameter feedback control 
loop: HLDS - LDS with zero-order holds {Hi} i on the 
input, CS - control synthesis, TS - control synthesis in 
time domain, SS - control synthesis in space domain,  

( ),Y x t  - distributed controlled variable,  ( ),W x k  - 

control variable, ( ),V x t  - disturbance variable,  

( ),E x k  - control error,  K - time/space sampling. 

 
In the block SS, approximation of distributed 

control error ( ),E x k , on the set of reduced 

steady-state distributed step responses 

( ){ },i i
HR x ∞H , is solved. 
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As the solution of approximation problem, 

the control errors vector ( ) ( ){ }i i
E k E k=
⌣

⌣

 enters 

into the block TS, where vector of control 
variables, ( )U k , is generated by controllers, 

( ){ }i i
R z  in single-parameter control loops.  



3. Modeling of temperature fields of 
melting glass in COMSOL Multiphysics  

 
Melting glass process is typical case of DPS. 

In the input/output relation it is possible to model 
it as LDS. Lumped inputs set flow rates of 
heating medium (earth gas and air) into series of 
burners located on both sides of the glass furnace 
above molten glass. Temperature field of the 
molten glass on the definition domain 2EΩ∈  

(in cross-section of the melting space) is 
distributed output variable, see Fig. 3. 

 

 
 
Figure 3. Scheme of recuperative gas glass tank 
furnace. 

 
Dynamics of a melting glass process as DPS 

is modeled in COMSOL Multiphysics 
environment with Heat Transfer Module, which 
offers very efficient tool for modeling and 
simulation scientific and engineering problems 
based on PDE. For the recuperative gas glass 
tank furnace with the cross flame was made two-
dimensional space model of the melting glass 
dynamics based on FEM. In the definition 
domain is supposed glass melting in steady-state 
and heating by the mixture of gas and air, which 
enter into four pairs of burners. Distribution of 
temperatures in molten glass in the definition 
domain 2E∈Ω  is modeled by PDE of parabolic 
type 
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with coefficients a, b and Neumann type 
boundary conditions for thermal insulation: 
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where n

�

 is the outward unit normal and q = 0, g 
= 0. 

 
In COMSOL Multiphysics environment, all 

parameters of PDE and other necessary 
conditions for simulation and data processing 
were specified through graphical user interface 
(GUI).  There by means of the toolbar menu in 
the Draw menu 2D geometry model of the 
melting glass furnace with definition domain 

2EΩ∈ and four subdomains iΩ  was drawn.   

Next, in the Physics menu subdomains of the 
melting glass with their parameters were defined. 
Parameters like thermal conductivity, density, 
heat capacity, absorbtion coefficient, diffusion 
coeficient and heat source were specified. Also 
in the Physics menu Boundary conditions were 
defined.  

In the Mesh menu mesh for the given 
geometry was analysed, e.g. initial mesh, various 
predefined mesh sizes, etc. The Mesh Statistics 
dialog box, available from the Mesh menu, 
contains statistical data for the current mesh.  

In the Solve menu temperature fields of the 
melting glass either in stationary, or transient 
form were computed by FEM. Actuating of flow 
heating medium was performed separately for 
each pairs of burners on subdomains iΩ .  

Obtained temperature fields were analyzed 
by means of various forms of plots and their 
parameters, including AVI animation with help 
of the Postprocessing menu, see Figs. 4 – 6, 
where are results for heating actuating by pairs 
of burners in the subdomain 1Ω . 

Finally, in the File menu Postprocessing data 
in the form of nodes, elements, data were 
exported either as txt or m-files to the Matlab -
Simulink. There LDS models of DPS for control 
synthesis purpose are created. 

 



 

 

 

 
Figure 4. Distributed transient response in steady-
state from each lumped input. 

 

 

 

 
 
Figure 5. Temperature fields in transient form along x 
and y axis actuated by heating in subdomain 1Ω . 



 

 
 
Figure 6. Temperature profiles in time t = 
[0:300:15000] seconds. 
 
 
4. DPS Blockset for MATLAB & 
Simulink 
 

For a software support of modeling, control 
and design of Distributed Parameter Systems 
given on complex 3D domains of definition, 
DPS Blockset for MATLAB & Simulink as 
Third-Party MathWorks Product has been 
developed [7], see Fig. 7. The library of DPS 
Blockset shows Fig. 8. 

The block HLDS models controlled 
distributed parameter systems as lumped-
input/distributed-output systems with zero-order 
hold units. The DPS Control Synthesis provides 
feedback to distributed parameter controlled 
systems in control loops with blocks for PID, 
algebraic, state space and robust control. The 
block DPS Input generates distributed quantities 
which can be used as distributed control 
variables or distributed disturbances, etc. DPS 
Display presents distributed quantities with 
many options including export to AVI files. The 
block DPS Space Synthesis performs space 

synthesis as an approximation problem. The 
block Tutorial presents methodological 
framework for formulation and solution of 
distributed parameter systems of control. The 
block Show contains motivation examples. The 
block Demos contains examples oriented to 
methodology of modeling and control synthesis. 
The DPS Wizard in step-by-step operation, by 
means of five model examples on 1D-3D with 
default parameters, gives a guide for 
arrangement and setting distributed parameter 
control loops.  
 

 
 
Figure 7. PS Blockset on the web portal of The 
MathWorks. 
 

 
 
Figure 8. The library of DPS Blockset for MATLAB 
& Simulink. 



5. Synthesis of control and simulation of 
control process  
 

Temperature fields of the melting glass 
obtained by FEM solution in COMSOL 
Multiphysics were exported to Matlab-Simulink, 
in order to determine lumped and distributed 

models. Transfer functions ( ){ }
1,4
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=
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used for control synthesis in time domain TS and 
reduced transient step responses in steady-state 
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solution of approximation task in the control 
synthesis in space domain SS.  

Transfer functions were identified in GUI 
ident of the System Identification Toolbox for 
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=
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where temperatures attain maximal values, e.g. 
for actuating in subdomain 1Ω  result of 

identification is on Fig. 9 and obtained discrete 
transfer function is in the form: 
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Simulation of the control process with four  

PID controllers was realised in the DPS Blockset 
for MATLAB & Simulink. By means of blocks 
of the DPS Blockset, DPS feedback control 
system with four PID controllers embedded in 
the DPS PID Synthesis block was arranged, see 
Fig. 10. Synthesis of PID controllers was 
adjusted in order to assure aperiodic running of 
the quadratic norm of distributed control error. 
Control objective is certain temperature required 
by technology with 10% divergence at most. 
Results of the PID control process for given 
reference quantity are on Fig. 11. 

  

 
 

Figure 9. Identification of partial transient response in 
subdomain 1Ω . 

 
 
Figure 10. PID feedback control loop in DPS 
Blockset. 
 

 
 

 
 

 



 
 

Figure 11. PID control of temperature field of the 
melting glass: distributed reference quantity ( ),W x ∞ , 

controlled quantity ( ),Y x ∞ , control quantities ( )iU k  

and quadratic norm of distributed control error 

( ),E x k . 

 
6. Conclusions 
 

Nowadays, a number of software products, 
environments and virtual try-out spaces for 
numerical dynamical analysis of machines and 
processes are at disposal, practically in all 
engineering disciplines. Based on powerful FEM 
solvers and advanced specific options, COMSOL 
Multiphysics provides an efficient and accurate 
solution which users need.  

Methodical approach presented in the paper 
demonstrates simple possibilities, how to exploit 
of distributed dynamical characteristics, obtained 
by numerical analysis of systems on complex 
definition domains for design of various control 
synthesis methods for distributed parameter 
systems. The DPS Blockset for MATLAB & 
Simulink provides block-oriented efficient 
software for this kind of tasks. 
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